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Note to the Author

This template has been provided by the Georgia Technology Authority Enterprise Portfolio Management Office.  Questions should be directed to epmo@gta.ga.gov

[This document is a template of an Issue Management Guideline document for a project. The template includes instructions to the author, boilerplate text, and fields that should be replaced with the values specific to the project.

· Blue italicized text enclosed in square brackets ([text]) provides instructions to the document author, or describes the intent, assumptions and context for content included in this document.

· Blue italicized text enclosed in angle brackets (<text>) indicates a field that should be replaced with information specific to a particular project.

· Text and tables in black are provided as boilerplate examples of wording and formats that may be used or modified as appropriate to a specific project.  These are offered only as suggestions to assist in developing project documents; they are not mandatory formats.

When using this template for your project document, it is recommended that you follow these steps:
1. Replace all text enclosed in angle brackets (e.g., <Project Name>) with the correct field values. These angle brackets appear in both the body of the document and in headers and footers.  To customize fields in Microsoft Word (which display a gray background when selected):
a. Select File>Properties>Summary and fill in the Title field with the Document Name and the Subject field with the Project Name.  
b. Select File>Properties>Custom and fill in the Last Modified, Status, and Version fields with the appropriate information for this document. 
c. After you click OK to close the dialog box, update the fields throughout the document with these values by selecting Edit>Select All (or Ctrl-A) and pressing F9.  Or you can update an individual field by clicking on it and pressing F9. This must be done separately for Headers and Footers.
2. Modify boilerplate text as appropriate to the specific project. 
3. To add any new sections to the document, ensure that the appropriate header and body text styles are maintained.  Styles used for the Section Headings are Heading 1, Heading 2 and Heading 3.  Style used for boilerplate text is Body Text.
4. To update the Table of Contents, right-click and select “Update field” and choose the option- “Update entire table”
5. Before submission of the first draft of this document, delete this “Notes to the Author” page and all instructions to the author, which appear throughout the document as blue italicized text enclosed in square brackets.
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[bookmark: _Toc382482398]1.0 Issue Management
[bookmark: _Hlt457809130][bookmark: _Toc449844909][bookmark: _Toc450105392][bookmark: _Toc382482399]1.1 Guideline Purpose
A.	The purpose of Issue Management is to record questions that could have a potentially negative effect on the attainment of project goals, and to resolve those conditions or situations in a manner that achieves the consensus of project management that each condition or situation has received due consideration based on a review of pertinent information.
B.	This guideline defines the methods and products for identifying, tracking, closing, and reporting issues that arise during the project life cycle.
[bookmark: _Toc382482400]1.3 Definitions
	Term
	Definition

	Configuration Management (CM)
	(1) The disciplines that create and maintain a controlled environment that protects intellectual assets by identifying the assets being protected, allowing re-creation of the assets in any version, tracking and controlling changes over time, informing affected groups and individuals of the status and content of the assets, and supporting planning for the activities within those disciplines. (2) The group responsible for implementing those disciplines.

	Configuration Manager
	The person with Configuration Management responsibility within a project or organization.

	Georgia Technology Authority (GTA)
	The State’s Authority for coordinating a comprehensive statewide Information Technology (IT) vision.  The GTA will provide agencies with technical assistance in strategic planning, program management, and human resources development.

	Issue
	(1) A topic of discussion, general concern, or legal dispute.  (2) A condition that exists or may exist that could change the assumptions, requirements, or constraints for the project, or that could cause re-evaluation of the project’s processes. 

	Issue Owner
	The person responsible for ensuring an issue or action item is properly managed.

	Process Improvement/ Lessons Learned (PILL)
	The mechanism for reviewing and improving principles, guidelines, forms, and templates contained in the GTA PMO Methodology.

	Program Management Consultant (PMC)
	The GTA PMO staff member assigned to provide consultation and mentoring in integrating the discipline of Project Management into all projects.

	Program Management Office (PMO)
	(1) An organizational entity responsible for management and oversight of the organization’s projects. (2) As a specific reference in this document, the PMO for the Georgia Technology Authority.
Alternatively, the acronym may stand for Project Management Office, with the same meaning as definition (1), above.  An organization may use both forms, with the Program Management Office generally having responsibility for multiple Project Management Offices.

	Project Change Request (PCR)
	Change requests may occur in many forms – oral or written, direct or indirect, externally or internally initiated, and legally mandated or optional.  The represent requests to expand or contract project scope, to modify cost or schedule estimates, etc.  The Project Management Plan must address the system that will be used to manage these requests.  This methodology uses a general-purpose form for submitting suggestions for change to the project. (GTA-PMO-FOR-053)

	Project Charter 
	A document that formally authorizes a project.  It should include all the information necessary for senior management to make this decision including the business need, product description with business, technical and quality objectives, high level budget and time estimates along with known constraints, assumptions, dependencies and risks.  The Project Charter contains the first agreed upon scope of the project.

	Project Management Plan (PMP)
	(1) At minimum, a documented statement of the intended actions an organization will take in pursuit of a project’s goals and objectives.  (2) A comprehensive statement of all key factors guiding a management team in their pursuit of project goals and objectives, the strategy and tactics the team will execute, and other information necessary to understand the project, its products and services, its organizational structures, and its intended actions.  (3) The specific document prepared as a project deliverable using the Project Management Plan template (GTA-PMO-TEM-030) as a model, the object of the methodology in this document.

	Quality Assurance (QA)
	(1) The function that ensures a project operates in a controlled environment that ensures the products and activities of the team comply with the following principles: Objective verification ensures products and activities adhere to applicable standards, guidelines, and requirements; affected groups and individuals are informed of project quality assurance activities and results; management addresses noncompliance issues that cannot be resolved within the project; and Quality Assurance activities are planned. (2) The disciplines employed by that group. (3) When quality initiatives are segmented into quality control, quality planning, and quality assurance, the specific disciplines concerned with ensuring management visibility into a project. 

	Risk
	(1) An event or condition that may occur, causing a negative impact on the project.  (2) The measure of probability of an occurrence, multiplied by its impact to project goals, expressed in dollars.

	Risk Assessment Report (RAR)
	A formal project deliverable, first approved at the end of the planning phase and continuously updated thereafter.  It presents the current risk profile for the project and defines the criteria for identifying risks in all key aspects of the project.

	Risk Manager (RM)
	The person assigned duties for the administrative tasks of risk management within a project.
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[bookmark: _Toc382482401]1.4 Process Owner
[bookmark: _Toc449844912][bookmark: _Toc450105395][image: ]A.	The PMO is responsible for the maintenance of this process.

[bookmark: _Toc27212867]Figure 1: Issues in the Change Process
[bookmark: _Toc382482402]1.5 General Logic
A.	By their very nature, projects have issues.  They are themselves processes to resolve an issue associated with a project.   Both issues and projects represent potential changes to business systems.  The issue management process is therefore part of a larger change control process. See Figure1.  
B.	Essentially, the process routes ideas for change into specialized processes for handling issues.  Issue management serves the larger process by gathering the information needed to make decisions.
C.  Projects may be initiated to address some issue in the organization.
D.	The general process includes a mechanism for submitting issues (change requests), mechanisms for deciding routing the handling of those issues, and the specialized sub-processes.  For the discussions in this document:
1.	The submitted ideas coming into the process are called issues.
2.	The submission mechanism can be a flow of paper forms, an email system, or a software application system that includes message routing.
3.	The routing mechanisms are identified, tracked and guided by the project management team.
E.	A single issue may pass through the routing mechanism several times, or may spawn other issues.  An issue, for example, will be assigned to someone at the time of submission for investigation and will return to the routing mechanism when the necessary facts are gathered.  Routing may also reclassify an issue.  An “issue” may be reclassified as a risk, as a process change, problem report, action item, or a Project Change Request (PCR).  Depending on the nature of the issue it may rejected, held for further investigation or monitoring, or resolved.
F.	The principles underlying change requests include:
1.	The project team must have a clearly identified communications channel for informing management of ideas, conditions, or events that need attention.
2.	The routing function incorporates review, classification, assignment, and transmission.
3.	Each sub-process that follows the routing represents a planned, repeatable response to a particular class of the need for change.
G.	Within this framework, an issue is defined as a condition that exists (or may exist) that could change the assumptions, requirements, or constraints for the project, or that could cause re-evaluation of the project’s processes.  Therefore:
1.	Unresolved issues may open a project to risk.
2.	Failing to close issues on a timely basis – “hoarding” – shortens the time management has to execute corrective action and gives the conditions that need correction time to grow.  This in turn can geometrically increase the chances of project failure.
3.	Trends in issue aging and volumes indicate the project’s correctness, risk, and progress.
[bookmark: _Toc382482403][bookmark: _Toc364151272][bookmark: _Toc364151506][bookmark: _Toc364212433][bookmark: _Toc364470930][bookmark: _Toc364500695][bookmark: _Toc364502437][bookmark: _Toc364647148][bookmark: _Toc364740277][bookmark: _Toc364749364][bookmark: _Toc364749585][bookmark: _Toc364750415][bookmark: _Toc364750660][bookmark: _Toc364754668][bookmark: _Toc364755524][bookmark: _Toc364816010][bookmark: _Toc367605575][bookmark: _Toc367605820][bookmark: _Toc449844916][bookmark: _Toc450105399]1.6 Procedural Overview
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[bookmark: _Toc27212868]Figure 2: Issues Guideline Overview
A.	Issue Management begins when someone suggests a matter should come to the attention of the project management team through the Project Change Request with issues as an identifier.  Management may conclude the matter is not a concern – but will more often decide otherwise.  The matter might be a “real” issue worth monitoring, or may represent a need to bring change to the project.  This procedure is therefore a method for gathering information at the front end of the general change control process. It also allows for escalation to a risk.
B.	The method involves:
1.	Structures to identify and transmit matters to project management
2.	Assignment of a tracking identification number to each transmission
3.	Review by management in the Project Status Review, with feedback to the person who originated the Change Request
4.	A decision by management whether the transmission contains enough information for closing the matter or initiating change, followed by:
a.	If enough information is available, a decision to either close the transmission as an issue that needs no further action, or to initiate the Risk Management (GTA-PMO-GLI-202), Change Control (GTA-PMO-GLI-201), or Process Improvement (GTA-PMO-GLI-011) Guideline.
b.	If the available information is not enough for that decision-making, initiate steps for gathering more information by:
i.	Assignment of the transmission to an owner, typically the submitter.
ii.	Direction to the owner to either monitor the matter, or to perform research (The directive is based on an assessment whether the information can be obtained at the current time.)
C.	As shown in the illustration, Figure 2, the core of the method is a communications loop.
[bookmark: _Toc507410801][bookmark: _Toc382482404]1.7 Guideline Goals
A.	The goal of this guideline is a project environment that provides a communication channel from the project team to management for matters the team feels need attention; that provides a means for gathering further information on those matters, to the point where management can decide whether project change is warranted; and that provides a means for monitoring matters under consideration.
[bookmark: _Toc507410802][bookmark: _Toc382482405]1.8 Standards
A.	Each transmission of a potential issue identified by the project team will be recorded, in project management software or through manual processing.  The minimum information to be recorded includes:
1.	Name of the issue
2.	Complete description of the matter of concern
3.	Tracking number
4.	Name of the submitter and date of submission
5.	Management action: Assigned for Monitoring, Assigned for Research, Risk Tracking Initiated, Change Request Initiated, Problem Report Initiated, Process Improvement/Lessons Learned (PILL) Initiated, or Closed
6.	Owner and date assigned, (if action is Assigned for Monitoring or Assigned for Research)
B.	During monitoring or research, each issue will have a designated owner when submitted.
C.	Project Managers may elect to perform the administrative functions of issue management personally, or may designate another member of the project team for administrative duties.
D.	The person responsible for administration of Issue Management will prepare information for review of potential issues in weekly project status meetings.
E.	Use of Issue Management software is recommended because of speed, control and ease of use.  Use of tracking spreadsheets with paper forms or a manually controlled email system is also acceptable.
[bookmark: _Toc507410803][bookmark: _Toc382482406]1.9 Responsibilities
[bookmark: _Toc457809314][bookmark: _Toc505579414][bookmark: _Toc507410804][bookmark: _Toc382482407]1.9.1 Program Manager
A.	Ensures Issue Management is conducted in each project within the program
[bookmark: _Toc505579415][bookmark: _Toc507410805][bookmark: _Toc382482408]1.9.2 Project Manager
A.	Customizes and maintains a planned Issue Management methodology
B.	Ensures project management software tools or manual systems used for Issue Management are maintained in a timely manner
C.	Selects project management tools and coordinates their installation
D.	Decides the action to take on each issue transmitted from the project team
E.  Ensures a timely review of issues
F.  Facilitates as needed from Issue to Risk
G. Ensures rigorous tracking is maintained
H. Ensures the implementation of accurate, timely, and complete issue tracking metrics
I. Coordinates Issue Management and the maintenance of Issue Management tools
J.   Performs tasks of Project Administrator if one is not assigned
K. Assures tasks of Quality Assurance functions are performed
L. Assures task of Configuration Management are performed
[bookmark: _Toc505579416][bookmark: _Toc507410806][bookmark: _Toc382482409]1.9.3 Project Team Members
A.	Identifies and reports issues
[bookmark: _Toc507410807][bookmark: _Toc382482410]1.9.4 Project Administration (PA)
A.	Customizes and maintain the Issue Management methodology
B.	Compiles metrics on Issue Management if part of the project’s performance measurement plan
C.	Documents and distributes issue notifications
D.	Participates in Issue Management discussions within weekly status reviews, recording the actions taken on each issue, and administering issue monitoring and research
[bookmark: _Toc449238711][bookmark: _Toc449513184][bookmark: _Toc505579418][bookmark: _Toc507410808][bookmark: _Toc382482411]1.9.5 Quality Assurance (QA)
A.	Ensures issues and actions are properly documented in accordance with guidelines
B.	Audits issue tracking on a periodic basis to ensure this procedure is being followed and that issues are being closed in a timely manner
C.	Identifies QA-related issues
[bookmark: _Toc449238712][bookmark: _Toc449513185][bookmark: _Toc505579419][bookmark: _Toc507410809][bookmark: _Toc382482412]1.9.6 Configuration Management (CM)
A.	Maintains the integrity of the Issue Management database, if applicable
B.	Defines the scheme for assigning tracking numbers to issues
C.	Reports Issue Management status metrics to the Project Manager on a periodic and event-driven basis
D.	Reports Issue Management status metrics at Program Reviews
E.	Identifies CM-related issues
[bookmark: _Toc449238714][bookmark: _Toc449513187][bookmark: _Toc505579421][bookmark: _Toc507410811][bookmark: _Toc382482413]1.9.7 Issue Owner
A.	Performs research on each risk assigned, records the research, and presents the research results to project management
B.	Monitors significant events affecting the status of the issue and its research activities, and records the tracking information
C.	Notifies the PA when the research is complete and advises the PA of the results of the issue monitoring on a weekly basis
[bookmark: _Toc507410812][bookmark: _Toc382482414]1.9. 8 Program Management Office (PMO)
A.	Provides Program Management Consultant (PMC) services for project oversight and mentoring
B.	Maintains the Issue Management Guideline for the GTA
C.	Reviews project issue tracking
D.	Provides for the evaluation, support, and acquisition of tools and trains for Issue Management, such as GTA standard project management tools
E.	Notifies GTA senior management of issue tracks metrics and reports cases where a project is not managing issues effectively
[bookmark: _Toc505579422][bookmark: _Toc507410813][bookmark: _Toc382482415]1.9.9 Program Management Consultant (PMC)
A.	Reviews the project’s Issue Management methodology
B.	Provides guidance and mentoring on Issue Management.
C.	Serves as liaison between the project and the PMO, especially with coordination of Issue Management status and metrics.
[bookmark: _Toc507410814][bookmark: _Toc382482416]1.10 Activities
[bookmark: _Toc505579425][bookmark: _Toc507410816][bookmark: _Toc382482417]1.10.1 Preparatory Activities

	Resources
	Activity
	Deliverable

	Project Manager and Project Administrator
	Develop plan for Issue Management, which must define:
1.	The method used to ensure identification of issues, and the communication of those issues to the project management team
2.	The metrics issue management is to generate
3.	The methods used to track and report issue management activities
	Issue Management Plan (or as a section in PMP)

	Project Manager and Project Administrator
	Coordinate selection and installation of project management tools that will meet the needs of the Issue Management Plan:
1.	Record the necessary data (refer to paragraph 1.8, Standards,) for a list of the minimum data requirements
2.	Route issue notifications to the responsible individuals
3.	Produce reports that include listings of the data recorded for each issue and metrics on Issue Management activity.
	Installed Tools

	Project Administrator
	Prepare and present Issue Management to the project team.  This is normally an item on the agenda of the project kickoff meeting
	Tracking log and Metrics

	Program Management Consultant
	Review tracking documents for issues; make recommendations to agencies; mentor best Issues Management Practices
	Reports at the GTA/PMO level

	Program Management Office 
	Review guidelines and practices; assure common metrics across all programs for Issues Management
	Issues, Principles and Guidelines



[bookmark: _Toc507410817][bookmark: _Toc382482418]1.10.2 Project Team Activities
[bookmark: _Toc507410818][bookmark: _Toc382482419]1.10.2.1 Identifying Issues
A.	Issue identification is a result of the “situational awareness” every team member should have, combined with the desirable habit of predicting the consequences of actions and events.  The question that should drive issue identification for each team member is, “Is this something that should be brought to the attention of project management?”
B.	Any time the answer to that question is yes, the team member should transmit information on the matter to the project’s Project Manager or if assigned, the Project Administrator.
[bookmark: _Toc507410819][bookmark: _Toc382482420]1.10.2.2 Reporting Issues
A.	Team members who become aware of potential issues record the information in project management software, on a paper form, or email.
B.	The minimum information to report includes:
1.	The name of the person reporting the issue
2.	The date of reporting
3.	A description of the issue (The issues description should include any known facts related to the matter, and an explanation why the matter is important.)
C.	To complete the notification, the team member (or the software) should transmit the information to the PA.
[bookmark: _Toc507410820][bookmark: _Toc382482421]1.10.3 Project Manager or Administrator
[bookmark: _Toc507410821][bookmark: _Toc382482422]1.10.3.1 Receiving Notifications
A.	On notification of an issue, the PA reviews the information supplied by the reporting team member; then completes the following status-tracking information in the project management software or in a manually-maintained spreadsheet for issue tracking:
1.	The information in the notification (name, date, and issues description)
2.	A name for the issue.  (This is a short issues tracking name used for reporting.)
3.	A tracking number (The project management software may assign the number automatically, or the Project Administrator (PA) will define the scheme for numbering.)
B.	The PA may additionally contact the team member to clarify the issue.  The clarification should be added as a note appended to the issue.
C.	Note that many “issues” reported to the PA will actually be requests for information.  As a rule, however, the PA should not treat such requests outside the Issue Management system.  The team not having notification is itself an issue.
[bookmark: _Toc507410822][bookmark: _Toc382482423]1.10.3.2 Preparing Notifications for Project Status Reviews
A.	Each periodic status meeting should include discussion of the notifications and decisions on the action to take with each issue, which may include:
1.	Recognizing the issue as a need for change to the project’s profile, products or services, or processes
2.	Recognizing the notification as an issue to be monitored and / or researched
3.	Closing the notification as an issue with no further action needed
4.   Escalating the issue to risk status
5.   Changing the issue to an action item, PCR, Problem Report, or process change
B.	Each decision should be noted in the meeting minutes with one or more action items.
C.	If the action is to recognize the issue as a risk, there is a need to change the project’s risk profile:
1.	The PA should be assigned an action item to close the issue, with the status Risk Tracking Initiated.
2.	The project Risk Manager (RM) should be assigned an action item to open a Risk Assessment Report (RAR) linked to the notification, and to proceed with the Risk Management Guideline.  The RAR should be based on the PMO Risk Assessment Report form (GTA-PMO-FOR-013) or on the requirements of the project management software used for Risk Management.
D.	If the action is to recognize the notification as the need for changing the project’s products or services, the discussion must also decide whether to treat the matter as a PCR as a Problem Report.  Refer to the Project Control Guideline (GTA-PMO-GLI-208).
1.	The PA should be assigned an action item to close the notification with the status PCR Initiated or the status Problem Report Initiated.
2.	The project Configuration Managers should be assigned an action item to open a PCR or Problem Report, and to proceed with the change control procedure.  Refer to the PMO Change Control Guideline (GTA-PMO-GLI-500).
E.	If the action is to recognize the notification as the need for changing the project’s processes:
1.	The PA should be assigned an action item to close the notification with the status PILL Initiated, and to complete a Process Improvement / Lessons Learned form.
2.	Management may also recommend a working solution to the need for process change, to implement within the project pending response from the PMO.  This recommendation should be made with the advice and concurrence of the PMC assigned to the project.
3.	If a working solution is recommended, the person assigned to analyze or implement the solution should refer to the Process Improvement Guideline (GTA-PMO-GLI-011) for guidelines and standards.
F.	With any of the preceding actions, the PA should note the appropriate tracking information for the resulting Risk Assessment Report, PCR, Problem Report, or PILL and the person assigned responsibility for the follow-on action should note the tracking number for the original notification.
G.	If the action is to recognize the notification as an issue:
1.	The PA should be assigned an action item to update the notification with the status Assigned for Monitoring, Assigned for Research, or Closed and to record the following information against the notification:
a.	The person assigned monitoring or research duties, typically the submitter
b.	The date of the assignment
c.	Notes made during the discussion of the notification (especially the reason the notification was closed without further action)
2.	The person who is to perform monitoring and / or research should be assigned an action item to perform those duties.  The action item should plainly state the objectives of the monitoring or research.
H.	Following the meeting, the person(s) assigned action items should start on the performance of the assigned actions.
I.   The solution may not reside with the assigned monitoring and research agent; however, it is their responsibility to:
	1.   Monitor progression
	2.   Recommend escalation to risk status
[bookmark: _Toc507410825][bookmark: _Toc382482424]1.10.3.3 Tracking Issues
A.	Stating that some number of issues has been identified is by no means sufficient for adequate project Issue Management.  The following activities must occur:
1.	Milestones should be tracked for each issue from the date of issue identification through the date of resolution.
2.	Progress tracking examines the steps in monitoring or researching the issues to ensure issue management stays on track and items do not drop “out of sight”.
3.	Issues should be reviewed at weekly staff meetings and as formal reviews.
B.	Issue Management activities are recorded in the schedule as any other tasks on the project with planned versus actual progress measured accordingly.
[bookmark: _Toc507410827][bookmark: _Toc457138955][bookmark: _Toc507410829][bookmark: _Toc382482425]1.10.3.4 Generating Reports
A.	Each week, reports are generated out of the PM database by the PA in preparation for the briefing at the periodic staff meeting.  These reports should cover not only the detail of the issues, but should also report the following metrics:
1.	Projected issue volume
2.	Actual issue volume
3.	Average time for issue closure
4.	Open issue aging to include:
a.	Number of issues less than one week
b.	Number of issues greater than one week and less than two weeks
c.	Number of issues greater than two weeks
B.	Issue volume (number of generated issues) that is significantly higher than the projected issue volume, or Open Issue Aging where there are more than a few issues are reported in the “red zone”, should be considered an issue to the project and should be reported to senior management by the Project Manager.
[bookmark: _Toc507410831][bookmark: _Toc382482426]1.10.4 Issue Owner Activities
[bookmark: _Toc507410832][bookmark: _Toc382482427]1.10.4.1 Researching Individual Issues
A.	The purpose of research is to gather enough information for management to decide whether a condition or event warrants a project change.  The definition of “enough information” will vary with each issue.  Research, however, should be conducted under these guidelines:
1.	Perform research with an objective in mind.
2.	The objective should relate to the probable handling the issue will receive when research has been completed:
a.	If the issue is potentially a risk, follow the steps for qualitative analysis in the Risk Management Guideline.
b.	If the issue relates to the project products or services, review agreed-to requirements and specifications as a foundation for the research into the issue’s impact.
c.	If the issue relates to project processes, consult with the PMC assigned to the project and review any pertinent PMO guidelines, procedures or guidebooks.
B.	On completing the analysis, the owner should notify the PA.
[bookmark: _Toc457138959][bookmark: _Toc507410833][bookmark: _Toc382482428]1.10.4.2 Monitoring Issues
A.	Management may properly adopt a “wait and see” tactic on a given issue, especially if issue identification is proactive.  That is, if the team is looking ahead aggressively, some issues are likely to be identified well in advance of any need for action. This should be a goal.  In such cases, and only if the issue does not represent a significant risk, management may assign an issue to an “owner” whose responsibility is monitoring the issue.
B.	At minimum, this includes preparation of a weekly update on the issue for the PA.
[bookmark: _Toc505579438][bookmark: _Toc505579434][bookmark: _Toc507410836][bookmark: _Toc382482429]1.10.5 Configuration Management Activities
A.	Establish configuration control numbering for issue notifications.
B.	Establish and maintain configuration control for the Issue Management documentation.
[bookmark: _Toc507410839][bookmark: _Toc382482430]1.11 Progress Tracking / Measurement
A.	Metrics for this process are defined in paragraph 1.10.3.4, Generating Reports, and in the specific elements of the issue notifications.  No additional measurements are required.
[bookmark: _Toc457809318][bookmark: _Toc507410840][bookmark: _Toc382482431]1.12 Verification
A.	QA will verify the Issue Management processes on a quarterly basis throughout the project life cycle. The activities and process will be reviewed by the PMO on a regular basis.  QA will conduct periodic audits of the process.
B.	QA will examine the process by use of the following questionnaire:

	Guideline, Deliverable or Form
	Document Number

	Issue Management Guideline
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